
 Win Change

JRE Enterprises presents Win Change for Windows.    Win Change consists of: three functions: 
Change Text, Find Text, and Find File Types.    Change Text provides an easy method to globally 
change data in INI, PIF, GRP, and other files across multiple drives, including network drives.    
Find Text provides an easy method to globally find text data within any type of    files.    Find File
Types provides an easy method to find files by file type(s).    When using the Win Change 
program, help text is displayed for items, at the bottom of the window, when the mouse pointer is 
placed over the items.

Win Change is coded using Microsoft Visual Basic and Microsoft Professional ToolKit for 
Visual Basic.
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Association of Shareware Professionals

This program is produced by a member of the Association of Shareware Professionals (ASP).    
ASP wants to make sure that the shareware principle works for you.    If you are unable to resolve
a shareware-related problem with an ASP member by contacting the member directly, ASP may 
be able to help.    The ASP Ombudsman can help you resolve a dispute or problem with an ASP 
member, but does not provide technical support for members' products.    Please write to the ASP 
Ombudsman at 545 Grover Road, Muskegon, MI USA 49442-9427, Fax 616-788-2765, or send 
a CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536.



 Becoming a Registered User

We thank you for giving Win Change a test drive.    Registration is easy and it ensures that we at 
JRE Enterprises can continue to develop low cost, quality applications for Windows.    When you
register, you will be sent a registration code that will stop the annoying "Unregistered 
Shareware" messages.

View REGISTER.WRI for current pricing information and registration form.

Related topics:
License Agreement
Registration Command
Registration Window



License Agreement
Copyright © 1993-1995 JRE Enterprises
All Rights Reserved

Installation of Win Change on your computer system implies agreement with the terms and 
conditions below.

Distribution of Win Change, its accompanying programs and documentation is considered as is.   
JRE Enterprises offers no warranties of any kind, expressed or implied.    This includes, but is in 
no way limited to, warranties of Win Change merchant ability or fitness for a particular purpose.  
Under no circumstances will JRE Enterprises be liable for any damages which result from the 
use of this program or the inability to use it.    Exclusion from liability includes, but is not limited
to, lost profits, lost savings, or any other incidental or consequential damages.

Win Change is distributed as Shareware.    It is not free, freeware, or in the public domain.    You 
may use Win Change for a trial period of thirty days, at no cost to you, to determine if it fits your
needs. If you decide to use Win Change past the thirty day trial period, you must register and pay
the applicable registration fee.    Individual copies of the unregistered version of Win Change 
may be given to friends and associates for the same thirty day free trial period.    You may also 
upload Win Change to the public section of a public BBS.

You may not modify or disassemble Win Change, nor distribute any modified or disassembled 
versions of Win Change.    Win Change may not be included with any other product without 
written permission from JRE Enterprises.

Registration of Win Change (the "SOFTWARE") permits you to use the "SOFTWARE" on a 
single computer.    The "SOFTWARE" is in "use" on a computer when it is loaded into temporary
memory (i.e., RAM) or installed into permanent memory (e.g., hard disk, CD-ROM, or other 
storage device) of that computer.    However, installation on a network server for the sole purpose
of internal distribution shall not constitute "use" for which separate license is required, provided 
you have a separate license for each computer to which the "SOFTWARE" is distributed.    You 
may make backup copies of Win Change as necessary for archival purposes only.

U.S. Government RESTRICTED RIGHTS: Use, duplication, or disclosure by the Government is
subject to restrictions as set forth in subdivision (b)(3)(ii) of the Rights in Technical Data and 
Computer Software clause at 252.227-7013.



Miscellaneous

Also available from JRE Enterprises are programs JRE Exit, JRE Home Inventory, My Life and 
Win Multiple Configurations.    JRE Exit is a freeware utility that provides four different ways to
exit Windows.      JRE Home Inventory is the Windows Home Inventory program that keeps 
track of all your household items for insurance purposes.    My Life is the definitive diary, word 
processor, scrapbook, and multi-media scrapbook available for Windows.    Win Multiple 
Configurations is the only utility that allows up to 100 different Windows configurations to be 
saved and restored!    Writer's Cramp is a Window's word processor with many features found 
in retail word processors, but with much lower machine requirements.    Theses programs can be 
found on CompuServe (WINSHARE forum) and America Online (Windows software) with a 
keyword of JRE.

JRE Enterprises can be contacted on CompuServe via mail to ID 71162,2311 or contacted on 
America Online via mail to ID LeeL641756.



 WCHG Program

    Win Change consists of: three functions: Change Text, Find Text, and Find File Types.    
Change Text provides an easy method to globally change data in INI, PIF, GRP, and other files 
across multiple drives, including network drives.    Find Text provides an easy method to globally
find text data within any type of    files.    Find File Types provides an easy method to find files by
file type(s).

Pressing the Change Text button will display the Change Text Window consisting of these folder 
items:

The Specify Changes folder item is where text change criteria can be entered.    Multiple 
change criteria can be entered.    Change criteria must be specified before other folder 
items can be used.

The Find Files folder item is where drives, directories, and file types are specified.    
Then, all files matching the change criteria, for the specified drives, directories and file 
types, will be listed.    Files must be found before the Apply Changes folder item can be 
used.

The Apply Changes folder item is where all found files are changed according to the 
change criteria.    Options concerning the creation back out files and whether to modify 
'read only' files are specified here, too.

The Backout Changes folder item is where back out files can be selected and restored, 
thus undoing any changes done by the Apply Changes process.    Back out files can also 
be deleted.

Note:    Certain types of    files contain internal checksums.    If these files are changed, 
they may become invalid.    Norton Desktop for Windows QAG files and Program 
Manager GRP files are two examples.    Win Change handles GRP files and will update 
their internal checksum.    QAG files should NOT be changed using Win Change, nor 
should any other type of filed containing internal checksums be modified by Win Change.
Always create back out files!!!

Pressing the Find Files by Text button will bring up the Find Files by Text Window consisting of 
these folder items:

The Specify Find Text folder item is where the find text criteria is entered.    Multiple find 
criteria can be entered.    Find criteria must be specified before the Find Files folder item 
can be used.

The Find Files folder item is where drives, directories, and file types are specified.    
Then, all files matching the find criteria, for the specified drives, directiories and file 
types, will be listed.



Pressing the Find Files by Type button will display the Find Files by Type Window where drives,
directories, and file types are selected for processing.    All files matching the file types, for the 
specified drives and    directiories, will be listed.

Pressing the Help button will display this help file.

Pressing the Exit button will close the active window.

The File menu item provides the ability to display the Change Text Window, Find Files by Text 
Window, and the Find Files by Type Window.    Clicking on the Exit menu item will terminate 
Win Change.    The Options menu item provides the ability to change the fonts being used, enable
or disable the minimize on use function, and to invoke the registration process.    The Help menu 
item provides the ability to display the about window, which gives the copyright notice and 
version/release number for Win Change.



 Change Text Window

The Change Text Window consists of the following four folders: Specify Changes, Find Files, 
Apply Changes, and Backout Changes.    A folder can be displayed by clicking on the tab for the 
folder.    Change criteria must be specified first, before the Find Files folder is available to be 
selected.    The Find Files process, the specification of drives, directories, file types and finding 
files, must be done before the Apply Changes folder is available to be selected.    Changes must 
have been applied before the Back Out Changes folder is available to be selected.

The Specify Changes folder item is where text change criteria is entered.    Multiple 
change criteria can be entered.    Change criteria must be specified before the Find Files 
folder item can be selected.

The Find Files folder item is where drives, directories, and file types are specified.    
Then, all files matching the change criteria, for the specified drives, directories and file 
types, will be listed.    Files must be found before the Apply Changes folder item can be 
used.

The Apply Changes folder item is where all found files are changed according to the 
change criteria.    Options concerning the creation back out files and whether to modify 
'read only' files are specified here, too.

The Backout Changes folder item is where back out files can be selected and restored, 
thus undoing any changes done by the Apply Changes process.    Back out files can also 
be deleted from this folder.

Note:    Certain types of    files contain internal checksums.    If these files are changed, they may 
become invalid.    Norton Desktop for Windows QAG files and Program Manager GRP files are 
two examples.    Win Change handles GRP files and will update their internal checksum.    QAG 
files should NOT be changed using Win Change, nor should any other type of filed containing 
internal checksums be modified by Win Change.    Always create back out files!!!



Specify Changes Folder

The Specify Changes folder allows multiple change criteria to be entered.    A maximum length of
149 characters is allowed.    'Change From' text must be specified, i.e. have a minimum length of 
one.    'Change To' text can be blank, i.e. have minimum length of zero.

The "Ignore case" checkbox determines whether a case-sensitive search is done.    When 
checked, the default, Win Change does a case-insensitive search when searching for the "Change 
from" string in files.    For example, an upper case "A" equals a lower case "a".    When 
unchecked, Win Change does a case-sensitive search.    For example, an upper case "A" does 
NOT equal a lower case "a".    Click on the "Ignore case" checkbox to toggle between checked 
and unchecked.    Win Change will use the case of the "Change to" string when updating.

To delete change criteria, double click on the criteria in either list box ("Change from" or 
"Change to").



Find Files Folder

The Find Files folder allows drives, directories, and file types to be selected for processing.    
Once selected, a list of all files which contain text strings that match any one of the "Change 
from" text strings will be produced.

Step 1: Select the drives you wish to search.    By default, only local drives are selected.    To 
select/unselect a drive, click on the drive letter.    A drive is selected when it is highlighted.    
Optional:    Specify a directory:\drive to use for the Quick Build process.

Step 2: Press the Build Dir List button to get a list of all directories on the selected drives.    This 
process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the directory list is built.    Optional:    Press the Quick Build button to get a list 
of all sub-directories for the specified drive:\directory.

Step 3: Select the directories you wish to search.    By default, all directories are selected.    To 
select/unselect a directory, click on the directory name.    To select/unselect a directory and all of 
its associated sub-directories, double-click on the directory name.    A directory is selected when 
it is highlighted.

Step 4: Enter the file types you wish to search.    Multiple file types can be entered.    By default, 
the following file types are searched: *.INI, *.GRP, *.PIF.    To delete a file type from the list, 
double click on it.

Step 5: Press the Find Files button to search for all files that contain one or more of the specified 
"Change from" text strings.    A list of all files that have a match will be produced.    This process 
may take some time to do.    Having Minimize on Use will cause Win Change    to minimize while
the found file list is built.

Step 6: Select the found files you wish to change.    By default, all found files are selected.    To 
select/unselect a found file, click on the file name.    A file is selected when it is highlighted.    At 
this point, the Apply Changes folder can be selected to apply the changes per the specified 
change criteria.    To view or edit a file, double-click on the file name.    Files can be copied, 
moved or deleted by pressing on the Drive button or the Toilet button, respectively.

To copy or move files, select the files to be processed, then click on the Drive button.    The Copy
or Move Selected Files Window will appear, select the destination drive and directory for the 
copy/move and then press the Copy Files or Move Files button.    Press the Exit button to exit the 
window.

To delete files, select the files to be processed, then click on the Toilet button.    A prompt will 
appear to verify whether to delete the selected files.    Choose OK to delete the files, Cancel to 
abort the delete process.



Apply Changes Folder

The Apply Changes folder allows the user to select whether to create back out files and whether 
files with the 'read only' attribute on will be modified.    By default, the create back out files 
option is selected, the modify 'read only' files is not selected.

Pressing the Apply Changes button will apply the change criteria to all selected found files.    
This process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the files are changed.    Win Change will issue a prompt to restart Windows.    If 
you manually restart Windows, then turn off "Save Settings on Exit" if it is on, before exiting 
Windows.    Otherwise, any changes to *.GRP files may be overwritten by Windows.

Note:    Certain types of    files contain internal checksums.    If these files are changed, they may 
become invalid.    Norton Desktop for Windows QAG files and Program Manager GRP files are 
two examples.    Win Change handles GRP files and will update their internal checksum.    QAG 
files should NOT be changed using Win Change, nor should any other type of filed containing 
internal checksums be modified by Win Change.    Always create back out files!!!



Backout Changes Folder

The Backout Changes folder allows the user to select which back out files to restore.    If 
problems occur after changes are applied, this process will restore the files back to their original 
state.    By default, all back out files are selected.    To select/unselect a back out file, click on the 
file name.    A file is selected when it is highlighted.

Pressing the Backout Changes button will undo any and all changes made to the selected files.    
This process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the files are being restored.    Win Change will issue a prompt to restart 
Windows.    If you manually restart Windows, then turn off "Save Settings on Exit" if it is on, 
before exiting Windows.    Otherwise, any changes to *.GRP files may be overwritten by 
Windows.

Pressing the Delete All Backout Files button will delete all backout files.    Once done, Win 
Change will no longer be able to backout its changes.    The deleting of the backout files may 
need to be done to free-up disk space.    Backout files are copies of all files changed by Win 
Change, before the changes were made.



 Find Files by Text Window

The Find Files by Text Window consists of the following two folders: Specify Find Text, and 
Find Files.    A folder can be displayed by clicking on the tab for the folder.    Find Text criteria 
must be specified first, before the Find Files folder is available to be selected.

The Specify Find Text folder item is where the find text criteria is entered.    Multiple find
criteria can be entered.    Find criteria must be specified before the Find Files folder item 
can be used.

The Find Files folder item is where drives, directories, and file types are specified.    
Then, all files matching the find criteria, for the specified drives, directiories and file 
types, will be listed.



Specify Find Text Folder

The Specify Find Text folder allows multiple find criteria to be entered.    A maximum length of 
149 characters is allowed.

The "Ignore case" checkbox determines whether a case-sensitive search is done.    When 
checked, the default, Win Change does a case-insensitive search when searching for the "Change 
from" string in files.    For example, an upper case "A" equals a lower case "a".    When 
unchecked, Win Change does a case-sensitive search.    For example, an upper case "A" does 
NOT equal a lower case "a".    Click on the "Ignore case" checkbox to toggle between checked 
and unchecked.

To delete find criteria, double click on the criteria in the list box.



Find Files Folder

The Find Files folder allows drives, directories, and file types to be selected for processing.    
Once selected, a list of all files which contain text strings that match any one of the "Find" text 
strings will be produced.

Step 1: Select the drives you wish to search.    By default, only local drives are selected.    To 
select/unselect a drive, click on the drive letter.    A drive is selected when it is highlighted.    
Optional:    Specify a directory:\drive to use for the Quick Build process.

Step 2: Press the Build Dir List button to get a list of all directories on the selected drives.    This 
process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the directory list is built.    Optional:    Press the Quick Build button to get a list 
of all sub-directories for the specified drive:\directory.

Step 3: Select the directories you wish to search.    By default, all directories are selected.    To 
select/unselect a directory, click on the directory name.    To select/unselect a directory and all of 
its associated sub-directories, double-click on the directory name.    A directory is selected when 
it is highlighted.

Step 4: Enter the file types you wish to search.    Multiple file types can be entered.    By default, 
the following file types are searched: *.INI, *.GRP, *.PIF.    To delete a file type from the list, 
double click on it.

Step 5: Press the Find Files button to search for all files that contain one or more of the specified 
"Find" text strings.    A list of all files that have a match will be produced.    This process may 
take some time to do.    Having Minimize on Use will cause Win Change to minimize while the 
found file list is built.

Step 6: Select the found files you wish to change.    By default, all found files are selected.    To 
select/unselect a found file, click on the file name.    A file is selected when it is highlighted.    To 
view or edit a file, double-click on the file name.    Files can be copied, moved or deleted by 
pressing on the Drive button or the Toilet button, respectively.

To copy or move files, select the files to be processed, then click on the Drive button.    The Copy
or Move Selected Files Window will appear, select the destination drive and directory for the 
copy/move and then press the Copy Files or Move Files button.    Press the Exit button to exit the 
window.

To delete files, select the files to be processed, then click on the Toilet button.    A prompt will 
appear to verify whether to delete the selected files.    Choose OK to delete the files, Cancel to 
abort the delete process.



 Find Files by Type Window

The Find Files by Type window allows drives, directories, and file types to be selected for 
processing.

Step 1: Select the drives you wish to search.    By default, only local drives are selected.    To 
select/unselect a drive, click on the drive letter.    A drive is selected when it is highlighted.    
Optional:    Specify a directory:\drive to use for the Quick Build process.

Step 2: Press the Build Dir List button to get a list of all directories on the selected drives.    This 
process may take some time to do.    Having Minimize on Use will cause Win Change to 
minimize while the directory list is built.    Optional:    Press the Quick Build button to get a list 
of all sub-directories for the specified drive:\directory.

Step 3: Select the directories you wish to search.    By default, all directories are selected.    To 
select/unselect a directory, click on the directory name.    To select/unselect a directory and all of 
its associated sub-directories, double-click on the directory name.    A directory is selected when 
it is highlighted.

Step 4: Enter the file types you wish to search.    Multiple file types can be entered.    By default, 
the following file types are searched: *.INI, *.GRP, *.PIF.    To delete a file type from the list, 
double click on it.

Step 5: Press the Find Files button to create a list of all files.    Having Minimize on Use will 
cause Win Change to minimize while the found file list is built.

Step 6: Select the found files you wish to change.    By default, all found files are selected.    To 
select/unselect a found file, click on the file name.    A file is selected when it is highlighted.    To 
view or edit a file, double-click on the file name.    Files can be copied, moved or deleted by 
pressing on the Drive button or the Toilet button, respectively.

To copy or move files, select the files to be processed, then click on the Drive button.    The Copy
or Move Selected Files Window will appear, select the destination drive and directory for the 
copy/move and then press the Copy Files or Move Files button.    Press the Exit button to exit the 
window.

To delete files, select the files to be processed, then click on the Toilet button.    A prompt will 
appear to verify whether to delete the selected files.    Choose OK to delete the files, Cancel to 
abort the delete process.



 Copy or Move Selected Files Window

The Copy or Move Selected Files window allows the user to specify where the selected files will 
be copied and/or moved.    Select the appropriate drive and directory, then press either the Copy 
Files button or the Move Files button.

Pressing the Exit button will close the window.



About Window

The About window displays the copyright notice, the version.release number, and the registration
status of Win Change.    The EXIT button will close the about window.



 Registration Window

The Registration window is used to enter the registration code and the registered person's name.  
After entering a valid registration code, the registered user will no longer receive the 
"Unregistered Shareware" messages.

The UPDATE button will validate the registration code and will write a valid registration code 
and the registered name to the WCHG.INI file.

The EXIT button will close the registration window.

Related topics:
License Agreement
Registration Command
About Window



About Menu Item

Displays the About Window, which gives the copyright notice and the release number for Win 
Change.



Registration Menu Item

Displays the Registration Window, which is used to enter the registration code and registered 
person's name.



Minimize on Use Menu Item

This menu item displays a check when "Minimize on Use" is enabled.    Clicking on the menu 
item will toggle between checked and unchecked.    When the menu item displays "Minimize on 
Use", Win Change will be minimized whenever a lengthy process occurs, such as building the 
directory list, finding files, or changing files.



Fonts Menu Item

The fonts item will display the sub-list:
Button
Fields
Labels

Click on the item for which you want to modify font defaults.    This will display the standard 
Windows Font Selection box.    Your choices will be applied immediately and will be saved 
automatically.    The next time you use Win Change, these new font defaults will be used.



Change Text Menu Item

This menu item displays the Change Text window, which provides an easy method to globally 
change data in INI, PIF, GRP, and other files across multiple drives, including network drives.



Find Files by Text Menu Item

This menu item displays the Find Files by Text window, which provides an easy    method to 
globally find text data within any type of    files, across multiple drives, including network drives.



Find Files by Type Menu Item

This menu item displays the Find Files by Type window, which provides an easy method to find 
files by file type(s), across multiple drives, including network drives.



Exit Menu Item

This menu item will terminate Win Change.



About Menu Item

Displays the About Window, which gives the copyright notice, the version.release number, and 
the registration status for Win Change.



Registration Menu Item

Displays the Registration Window, which is used to enter your name and registration number.



Fonts Menu Item

The fonts item will display the sub-list:
Button
Fields
Labels

Click on the item for which you want to modify font defaults.    This will display the standard 
Windows Font Selection box.    Your choices will be applied immediately and will be saved 
automatically.    The next time you use Win Change, these new font defaults will be used.



Minimize on Use Menu Item

This menu item displays a check when "Minimize on Use" is enabled.    Clicking on the menu 
item will toggle between checked and unchecked.    When the menu item displays "Minimize on 
Use", Win Change will be minimized whenever a lengthy process occurs, such as building the 
directory list, finding files, or changing files.






